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GETTING STARTED
Successful installation may require minor adjustments to the configuration of
your Macintosh' or Windows” operating systems and/or hardware
component drivers.

Windows” Minimum System Requirements

•Windows 3.1 or Windows 95

•33 MHz 486 processor or higher

•8MB RAM

•SVGA graphics card (640 X 480, 256 colors)

•Windows compatible sound card

•Double (2X) speed CD-ROM drive
•Hard disk with approximately 12K free space

•Mouse

Additional Requirements

Your monitor must be set to 256 colors. Monitor
settings can be adjusted in Windows 95 by first
opening the Control Panel folder located in the
Settings folder in the Start menu. Double-click on
the Display icon and click on the Settings tab.
Choose 256 Colors under the Color Palette. For
Windows 3.1, please consult your computer’s

documentation for instruction on adjusting your
monitor settings.
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Starting the Game on Windows 95

When you insert the CD into your computer’s CD-ROM drive the Broderbund
Startup window will appear, giving you the option to play the game or electroni¬
cally register the product with Broderbund Software. To start the program, click
Play. The first time the program is launched, a Gregory and the Hot Air Balloon
icon will be created in the Broderbund Software folder in the Start menu. The
program will also create a folder called “Balloon” on the C: drive to store any

games you save.

If your system does not automatically display the Broderbund Startup window,

double-click on the My Computer icon on the desktop and then double-click on
the Gregory CD-ROM icon in the folder. The Broderbund Startup window will
appear. Click Play to launch the program.

It’s a good idea to register the product with Broderbund Software in order to
assure free technical support and to receive notice of special offers. Click
Register when the Startup window appears. It will guide you through the elec¬
tronic registration process (your computer needs a modem to do this). Although

the Register button will continue to be active on the Startup window each time

the CD is inserted, you only need to complete the registration process once.

Starting the Game on Windows 3. 1

Place the CD into your computer’s CD-ROM drive. From the Program Manager

select Run from the File menu. In the Command Line, type: D:\setup and click

the OK button (if your CD-ROM drive is not drive D:, substitute the correct
drive’s letter). The first time the program is launched, a Gregory and the Hot Air
Balloon icon will be created within the Broderbund Software program group in
the Program Manager. The program will also create a folder called “Balloon” on

the C: drive to store any games you save. To launch the game, open the
Broderbund Software program group. Double-click on the Gregory and the Hot
Air Balloon icon.

Macintosh Minimum System Requirements

•Macintosh and Power Macintosh

•System 7.1 or higher

•33 MHz 68040 processor or higher

•8MB RAM, 3MB free RAM

•Hard disk with approximately 12K free space

•Double (2X) speed CD-ROM drive

•256 color graphics, 13 inch monitor

•Mouse

Additional Requirements

Virtual Memory must be off in order to run Gregory and the Hot Air Balloon. To
do this, double-click Memory in your Control Panels and turn Virtual Memory
off. Restart your computer.

Starting the Game on the Macintosh
Insert the CD into your computer’s CD-ROM drive. The Gregory and the Hot Air
Balloon CD window will automatically open. Double-click on the Gregory icon
in the window to launch the program. A folder called “Gregory” will be created
in the Preferences folder in your computer’s Systems Folder to store any games
you save.
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PLAYING THE GAME

Gregory and the Hot Air Balloon is designed to let you explore the game with
ease. Throughout the game you will have access to these helpful features:

REGOKY AND THE HOT AlR BALLOON
Welcome to Acorn Hollow, the home of Gregory Chuckwood. Gregory and his
pet lizard, Newt, are eager to go into town for a thrilling ride in Mr. Underwoods
hot air balloon. When the balloon gets loose and crash lands near a carnival,

Gregory’s big adventure begins. It’s up to you to help him collect the things he
needs to get back home. While searching for these items inside the carnival, you

and Gregory will have fun discovering delightful games and toe-tapping music. —* . M w:
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The Options menu is where you can save a game, load a game, or exit the game.

Once you have launched the game, you can press the Esc key at any

time to go to the Options menu.
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Saving a Game
To save your place in the game, click the Save button. The cursor will turn into a
miniature picture of the location where you are in the game. Move the picture to
one of the blank boxes on the screen. Click on the box to release the picture.

Then type your name and press Return.

Loading a Game
To load a saved game, click on the picture that corresponds to the game you
want to play.

Exiting the Game
Clicking on the red Stop sign will quit the program. (Note: You can also quit the
program at any time during the game by using key commands. Windows users
can quit by pressing the Alt-F4 keys. Mac users can quit by pressing the §§-Q

keys.)

To leave the Options menu and return to the current game, click on the arrow in
the upper right hand corner of the screen.

INTERRUPTING THE GAME

Some animations can be bypassed by pressing the Space bar. To skip the
opening titles, the balloon rides, and the closing credits, press the Space bar
when the animation begins.

STANDARD CURSORS AND BUTTONS

There are a variety of cursors which appear throughout the game:

The standard cursor is a small white paper airplane.

If the cursor changes to a small yellow paper airplane, it indicates a
hot spot - an area that, when clicked, will animate in some way.Y~\>

When the cursor changes to a large yellow paper airplane, this
indicates an exit. Clicking when the cursor is in this shape will
take you to another location.

>-

This exit button can be found in each activity. Clicking this
button will end the activity and allow you to continue exploring
the carnival.
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\3.GREGORY’S BACKPACK

Throughout the adventure, you will be collecting and using various items. The
backpack, which is always seen at the bottom of the screen, shows you what
items Gregory has in his possession.

To add an item to the backpack, click on the item. If the item will be useful
during the game, it will disappear from the screen and reappear in the backpack.

Some situations require Gregory to use an item in his backpack to accomplish a

task. To retrieve an item from the backpack, click on the desired item. If the item

can be used in that situation, the cursor will turn into that item. Click on an

object with the cursor to prompt Gregory to use the selected item. If the item

cannot be used, it will remain in the backpack.

When Gregory first lands near the carnival,

he jots down the items he needs to get back
home. This reminder note remains in
Gregory’s backpack. Click on the note and
Gregory will remind you what items still
need to be collected.

Go to
Next
Page

£
I

CA

Repeat
Narrationi mm*.

*

Storybooks in the Acorn Hollow Bookstore

There are three storybooks to enjoy in the Acorn Hollow Bookstore. Each page
is narrated to you. Additionally, you can click on individual phrases to have them
read again. To have the whole page repeated, click on the page number in the
lower right corner of the page. To turn the page, move the cursor to the right

edge of the page and click when the cursor becomes a large yellow paper air¬
plane. To close the book, move the cursor to the top left corner of the page and
click when the cursor turns into a pink arrow.
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Mr. Barker’s Carnival

Once inside the carnival, you can direct Gregory to one of the activity areas.

All of the items Gregory will need to get home can be found in the carnival.
However, the location of some of the items may change from one game to

the next.

THE GREAT MENTALEO

Click on the Great Mentallo and he will challenge you to a guessing game. Accept

the challenge and you must guess what he is thinking. The Great Mentallo will
give a clue and you must use letter recognition skills to pick the correct object

from the five pictures shown. Quit the activity at any time by clicking on the
pink arrow in the upper left corner of the screen.
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MACMOO’S ICE CREAM STAND

Click on Mrs. MacMoo and you will have a ball making ice cream sundaes! Inside
the Sundae Maker activity, the cursor will become a scoop of ice cream, allowing

you to fill a large bowl with a variety of flavors. Click on a container of ice cream

to change flavors. To add toppings, click on any of the dry or gooey toppings. The
cursor will change to reflect the choice of topping. Click on the pile of empty

bowls to start from scratch. Exit the activity at any time by clicking on the pink

arrow in the upper left corner of the screen.

THE MIRROR GAME

Inside the Fun House is the Mirror Game where you will delight in changing

Gregory’s reflection to make him look thin, fat, wavy, and just plain silly. Click

on the mirrors individually to change part of the reflection, or click on the pail

to change all three mirrors at once. To exit the activity at any time, click on the
pink arrow in the upper left corner of the screen.
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THE TRAMPOLINE ROOM

The Trampoline Room is located inside the l?un House. Using the mouse, you can
navigate Gregory across the trampolines. Click on one of the trampolines to
make Gregory jump there. Clicking on the exit platform on the right side of the
screen will cause Gregory to move one trampoline to the right, or onto the exit

platform if he is already on the far right trampoline. Clicking on the entrance
platform will cause Gregory to move one trampoline to the left, or onto the
entrance platform if he is already on the far left trampoline. Gregory must be
on one of the platforms or on the far right or far left trampoline before the exit
cursor is available.

The Journey Back Home
The Map Game

When you have helped Gregory find everything he needs, it’s time to go home.
Gregory needs you to navigate the balloon back to Acorn Hollow.

Each click of the mouse sends a gust of wind in the direction
the arrow-shaped cursor is pointing. You must blow the balloon
along the path, avoiding the mountains, until Gregory and Newt

— -*1 arrive at Acorn Hollow.

A

1716



Paula Bone

Audio Engineering and
Sound Design
Rob Christiansen
Allen Palmer
Tony Trippi

Assembly
Boris Shabashev
Audrey Gorskij
Asy Patrysheva

Animators
Marina Miheeva
Kostya Biryukov
Katya Gorelova
Lena Rumyantseva
Anna Zibrova
Aleksey Gorbunov
Sergey Mironov
Pavel Zhuravlev
Dima Savik
Tanya Demidova
Oksana Romanova
Olya Trifanenkova
Katya Kruglova
Ira Nikiforova
Lena Savik
Vladimir Korolkov
Elvira Gizatullina
Marina Tchestnakova
Natasha Beltyukova

Background Artists
Sergey Kurbatov
Nadya Obedkova
Lena Streltsova
Anastasya Skvortsova
Vera Koroleva
Lena Malyshenkova
Ira Shostyk
Dima Anopov
Olya Dyankina
Natasha Fedorova

Gregory's Voice
Peter Kozodoy

Voices and Singers
John Davin
Alice Johnson
Jeremiah Kissel
Chloe Leamon
Merle Perkins
Wren Ross
Kria Sakakeeny
Wendy Sakakeeny

Musicians
Tony Trippi
Bill Novik
Bill Reynolds
Jonathan Wheatley

Color Models
Sasha Naumova
Natasha Yakovleva

TROUBLESHOOTING
Below are some technical support hints for Gregory and the Hot Air Balloon. For

additional help, please refer to the Troubleshooting Guide included in the box

before contacting our Technical Support representatives.

Windows 95
If you are having problems saving or loading games from the Options menu:
Check to see that there is a folder called “Balloon” on your C: drive. Renaming,

moving or deleting this folder can result in the loss of previously saved games.
A new “Balloon” folder will be created the next time the program is launched.

Windows .3.1
If you are having problems saving or loading games from the Options menu:
Check to see that there is a folder called “Balloon” on your C: drive. Renaming,

moving or deleting this folder can result in the loss of previously saved games.
A new “Balloon” folder will be created the next time the program is launched.

If there is no Gregory icon in the Broderbund Software program group:
Follow the instructions for running the setup (see “Starting the Game on
Windows 3.1” page 4). When you run the installation, a Gregory icon will be cre¬
ated in the Broderbund Software program group.

.REDITS
apitol Multimedia:

Executive Producers
Igor Razboff
Boris Bigoulaev

Produced by
Dale DeSharone

Directed by
Timothy R. Phillips

Larissa Shabasheva

Written by
Matt Sughrue

Music Composed and
Performed by
Tony Trippi

Character Design

Masha Kolesnikova

Background Design
Vitaly Titov
Sergey Kurbatov

Animation Director
Masha Yakushina

Software Engineering
Denis Bekman
Mikhail Tchekmarev

Production Management
Lyuba Nedorezova
Olga Sumenko

•*

Macintosh
If you are having problems saving or loading games from the Options menu:
Open the System Folder on the computer and check to see that there is a folder
called “Gregory” in the Preferences folder. Renaming, moving or deleting this
folder can result in the loss of previously saved games. A new “Gregory” folder
will be created the next time the program is launched.
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BRODERBUND 90-DAY SATISFACTION GUARANTEEDesign Coordinators:
Joyce Anderson
Lisse Hooker

Package and
Documentation Design:

Deborah Mills

Special Thanks To:
The Broderbund Quality

Assurance Department

Inna Savitskaya
Natalya Yakovleva
Ira Burakova
Tanya Lihovskaya
Ira Kallinikova
Alla Kiseleva
Lena Lesakova
Lena Alekseeva

Broderbund Software:
Producer:
Leah Antignas

Assistant Producer:
Heather Steil

Lyuba Dudenkova
Andrey Purtov
Kristina Kim
Olga Maximova
Eugenij Tyulkin

Special Effects
Anton Lomakin

Technical Assistance
Tanya Smirnova
Denis Ivanov
Lyuda Rozman
Larisa Gritsenko

Quality Assurance
Anton Chizov
Andrey Pugachev
Vera Taranova
Aleksey Konkin
Ira Pleshak

If you are not completely satisfied with your purchase, return the product to

Broderbund Software within 90 days of the date of purchase, along with the
original sales receipt and the reason for return. Please state whether you would
prefer another Broderbund product of equal or lesser value, or a full refund.

Limit 1 per household. Dealers, distributors and their employees are not eligible.

Please call Broderbund Customer Support at (415) 382-4745, or return the mer¬

chandise to Broderbund Software, P.O. Box 6125, Novato, CA 94948-6125. If you

wish to return the product via U.P.S., please send it to Broderbund Software,

Attention Customer Support, 775 South Point Boulevard, Petaluma, CA 94954.

The Broderbund 90 Day Satisfaction Guarantee also warrants for a period of 90
days that this copy of Gregory and the Hot Air Balloon is free from substantial
errors or defects that will materially interfere with the operation of the program
as described in the enclosed user documentation. This policy applies to the initial
purchaser only.

If you believe you have found any such error or defect in the program during the
90 day period, call Broderbund's Technical Support Department at (415)382-4700

between the hours of 7 a.m. and 5 p.m. (Pacific Time), Monday through Friday.

Broderbund Technical personnel will attempt to help you correct or avoid the
problem. If any such error or defect cannot be corrected or reasonably avoided,

Broderbund will inform you how to obtain a corrected program disk (or you may

inform Broderbund that you prefer another Broderbund product of equal or

lesser value, or a full refund)

and
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Tanya Tavrueva
Edward Boldin
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Karen Omholt

Assistant Marketing
Manager:
Ellen Jacobson

Creative Director:
David Kessler
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lerm is defined in Clause 252.227-7013(c)(l) of the DFARS; and

(ii) if the Software are supplied to any unit or agency of the United States
Government other than DoD, the Government’s rights in the Software, and its
documentation will be as defined in Clause 52.227 19(c)(2) of the FAR or, in the
case of NASA, in Clause 18-52.227-86(d) of the NASA Supplement to the FAR.

DISCLAIMER OF WARRANTY

You expressly acknowledge and agree that use of the Software is at your sole risk.
The Software, and related documentation are provided “AS IS” and without
warranty of any kind. If for any reason you are dissatisfied with the software,
return the product with your original sales receipt to Broderbund within 90 days
of the date of purchase for a full refund or a replacement product of equal or
lesser value. Broderbund Expressly disclaims all warranties, express or implied,
including, but not limited to, the implied warranties of merchantability and
fitness for a particular purpose. Broderbund does not warrant that the functions
contained in the software will meet your requirements, or that the operation of
the software will be uninterrupted or error-free, or that defects in the software
and the fonts will be corrected. Furthermore, Broderbund does not warrant or
make representations regarding the use or the results of the use of the software
or related documentation in terms of their correctness, accuracy, reliability, or
otherwise. No oral or written information or advice given by Broderbund or a
Broderbund authorized representative shall create a warranty or in any way
increase the scope of this warranty. Should the software prove defective, you
(and not Broderbund or a Broderbund authorized representative) assume the
entire cost of all necessary servicing, repair or correction. Some jurisdictions do
not allow the exclusion of implied warranties, so the above exclusion may not
apply to you.

WARRANTY
RESTRICTIONS

The Software contains copyrighted material, trade secrets and other proprietary

material. In order to protect them, and except as permitted by applicable

legislation, you may not decompile, reverse engineer, disassemble or otherwise

reduce the Software to a human-perceivable form. You may not modify, network,

rent, lease, loan, distribute or create derivative works based upon the Software in

whole or in part. You may not electronically transmit the Software from one

computer to another or over a network.

EXPORT LAW ASSURANCES

You agree and certify that neither the Software nor any other technical data
received from Broderbund, nor the direct product thereof, will be exported

outside the United States except as authorized and as permitted by the laws and
regulations of the United States. If the Software has been rightfully obtained by

you outside of the United States, you agree that you will not re-export the

Software nor any other technical data received from Broderbund, nor the direct
product thereof, except as permitted by the laws and regulations of the United
States and the laws and regulations of the jurisdiction in which you obtained the

Software.

GOVERNMENT END USERS

If you are acquiring the Software on behalf of any unit or agency of the United

States Government, the folowing provisions apply. The Government agrees:

(i) if the Software are supplied to the Department of Defense (DoD), the Software
are classified as “Commercial Computer Software” and the Government is
acquiring only “restricted rights” in the Software, and its documentation as that

2322



LIMITATIONS ON WARRANTY

Unauthorized representations: Broderbund warrants only that the program will
perform as described in the user documentation. No other advertising,

description or representation, whether made by a Broderbund dealer, distributor,

agent or employee, shall be binding upon Broderbund or shall change the terms
of this warranty.

No consequential damages: Broderbund shall not be liable for special, incidental,
consequential or other damages, even if Broderbund is advised of or aware of the
possibility of such damages. This means that Broderbund shall not be responsible

or liable for lost profits or revenues, or for damages or costs incurred as a result
of loss of time, data or use of the software, or from any other cause except the
actual cost of the product. In no event shall Broderbund’s liability exceed the
purchase price of this product. Some states do not allow the exclusion or
limitation of incidental or consequential damages, so the above limitation or
exclusion may not apply to you.

You are entitled to use this product for your own use, but may not sell or
transfer reproductions of the software or manual to other parties in any way,

nor rent or lease the product to others without the prior written permission of

Broderbund. You may use one copy of the product on a single terminal connect¬
ed to a single computer. You may not network the product or otherwise use it on
more than one computer or computer terminal at the same time.

For technical support, on this or any other Broderbund product, call
415/382-4700.

PLEASE DO NOT MAKE ILLEGAL COPIES OF THIS SOFTWARE

The software you are using was produced through the efforts of many people: designers,
artists, programmers, distributors, retailers and other dedicated workers.

The costs of developing this and other software programs are recovered through software
sales. The unauthorized duplication of personal computer software raises the cost to all
legitimate users.

This software is protected by federal copyright law. Copying software for any reason other
than to make a backup is a violation of law. Individuals who make unauthorized copies of
software may be subject to civil and criminal penalties.

Broderbund Software, Inc. as a member of the Software Publishers Association (SPA) sup¬
ports the industry’s effort to fight the illegal copying of personal computer software.

Report any copyright violation to:
SPA
1101 Connecticut Avenue. NW. Suite 901
Washington, D.C. 20036
202-452-1600
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